RESOURCE AND PATIENT MANAGEMENT SYSTEM

IHS Emergency Department Dashboard

(BEDD)

Installation Guide and Release Notes

Version 2.0
June 2015

Office of Information Technology (OIT)
Division of Information Technology
Table of Contents

1.0  Release Notes .......................................................................................................................... 1

2.0  Installation Notes ................................................................................................................... 2

  2.1  Contents of Distribution ........................................................................................................ 2

  2.2  Required Resources .............................................................................................................. 2

  2.3  Before You Begin: Installation Issues .................................................................................. 3

3.0  Installation Instructions ............................................................................................................ 4

  3.1  Disk Space ............................................................................................................................. 4

  3.2  Pre-installation ....................................................................................................................... 4

4.0  Sample Installations .................................................................................................................. 5

  4.1  BEDD XML/Ensemble Installation ....................................................................................... 5

      4.1.1  Open Ensemble Studio ................................................................................................. 5

      4.1.2  Import the bedd0100p1.xml file ............................................................................... 6

  4.2  BEDD KIDS Installation ....................................................................................................... 9

  4.3  Sample Cache Install ........................................................................................................... 10

5.0  Installation Configuration ......................................................................................................... 14

  5.1  Add User Security Keys ..................................................................................................... 14

  5.2  Configuring the Cache Server Page (CSP) Application ..................................................... 15

      5.2.1  Enable System Authentication Options ................................................................ .... 16

      5.2.2  Create New CSP Application .................................................................................... 16

      5.2.3  Update Ensemble’s UnknownUser ............................................................................. 19

  5.3  CSP Gateway Installation .................................................................................................... 21

      5.3.1  Install Cache Shell ....................................................................................................... 22

      5.3.2  Configure IIS ................................................................................................................. 27

      5.3.3  Configure CSP Gateway ............................................................................................. 31

  5.4  Application Access Setup .................................................................................................... 35

      5.4.1  Stand Alone Setup ....................................................................................................... 35

      5.4.2  EHR Setup .................................................................................................................... 37

Acronym List .................................................................................................................................. 44

Contact Information ....................................................................................................................... 45
Preface

The purpose of this manual is to provide the user with the information required to install version 2.0 of the IHS Emergency Department Dashboard (EDD).
1.0 Release Notes

The EDD is a tool that electronically enables facilities to run and manage their emergency and or urgent care clinics. The EDD is dependent on the Resource and Patient Management System (RPMS) Emergency Room System (ERS) in the AMER namespace. EDD was built on the ERS foundation to enhance patient flow and provider communication.

EDD can be set up to operate as a standalone icon on the staff computer or can be accessed from within the RPMS Electronic Health Record (EHR) application.

EDD gets its data and updates from one of four ways: ERS, Dashboard Edit, or EHR data or a combination of all three.
2.0 Installation Notes

Prefix: BEDD
Current Version: 2.0

2.1 Contents of Distribution

The BEDD v2.0 distribution contains the following items documented in Table 2-1.

Table 2-1: Contents of Distribution

<table>
<thead>
<tr>
<th>File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>bedd0200xml.zip (containing bedd0200.xml)</td>
<td>Ensemble import file</td>
</tr>
<tr>
<td>bedd0200.k</td>
<td>KIDS file</td>
</tr>
<tr>
<td>bedd020i.pdf</td>
<td>Installation guide and release notes</td>
</tr>
<tr>
<td>bedd020t.pdf</td>
<td>Technical manual</td>
</tr>
<tr>
<td>bedd020u.pdf</td>
<td>User guide</td>
</tr>
</tbody>
</table>

2.2 Required Resources

Table 2-2 contains the RPMS software which is required in order for the BEDD software to run properly.

Table 2-2: Require RPMS Software

<table>
<thead>
<tr>
<th>Module</th>
<th>Minimum Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Veterans Administration (VA) FileMan (DI)</td>
<td>v22.0 Patch 1003</td>
</tr>
<tr>
<td>VA Kernel (XU)</td>
<td>v8.0 Patch 1015</td>
</tr>
<tr>
<td>IHS/VA Utilities (XB)</td>
<td>v3.0 through Patch 11</td>
</tr>
<tr>
<td>ER Visit System (AMER)</td>
<td>V3.0 Patch 6</td>
</tr>
<tr>
<td>Patient Care Component PCC Data Entry (APCD)</td>
<td>v2.0 through Patch 10</td>
</tr>
<tr>
<td>IHS PCC Suite (BJPC)</td>
<td>v2.0 Patch 11</td>
</tr>
<tr>
<td>EHR 1.1</td>
<td>v1.1 Patch 14</td>
</tr>
<tr>
<td>Lexicon Utility (LEX)</td>
<td>v2.0 Patch 1003</td>
</tr>
<tr>
<td>IHS EMERGENCY DEPT DASHBOARD (BEDD)</td>
<td>V1.0 (XML and KIDS Builds)</td>
</tr>
</tbody>
</table>
2.3 Before You Begin: Installation Issues

The Ensemble import file (bedd0200.xml) is being delivered in a zipped (compressed) format. It has been determined that transferring the file in an uncompressed format will corrupt it so that it will not import properly into Ensemble. When retrieving the file therefore, do not extract the file from its zipped state until it has been placed directly into the desired import folder.
3.0 **Installation Instructions**

The process to install version 2.0 of the BEDD application requires the installation of two builds. The first build that needs to be installed is an XML release that needs to be imported into Ensemble first. Following the XML installation will be a standard KIDS build installation. Following the installation of the builds, if the previous version of the BEDD application has not been installed in the past, then a number of post-installation steps must be completed.

3.1 **Disk Space**

With Version 2.0 of BEDD, approximately 5 MB of disk space on the server is needed to install the Cache Server Page (CSP) and Cache Class files contained in the bedd0200.xml file. Additional storage space will be needed to store patient information entered through the EDD.

3.2 **Pre-installation**

Before installing the BEDD application, the following items should be completed (in no particular order):

- If possible, initially load the software into a test account, then into the production account. There are no routines or globals to remove after the installation is complete.
- Refer to the sample installation instructions for the applicable prompts and user responses. User responses appear in bold type.
- Ensure the other required applications have been installed.
4.0 Sample Installations

4.1 BEDD XML/Ensemble Installation

This section begins the BEDD installation process. It describes the process of importing the BEDD application into Ensemble Studio from an XML file.

4.1.1 Open Ensemble Studio

1. Click the Ensemble cube in the system tray (at the right end of the Windows Taskbar) and click Studio, as shown in Figure 4-1. A login ID and password may be required.

![Figure 4-1: Open Ensemble Studio](image)

2. The Ensemble Studio window is displayed, as shown in Figure 4-2.

3. On the File menu, click Change Namespace to open the Cache Connection Manager Dialog box.
4. Select the appropriate namespace from the **Cache Connection Manager** dialog box and click **OK**, as shown in Figure 4-3.

![Cache Connection Manager](image)

**Figure 4-3:** Select the appropriate namespace to import to

4.1.2 **Import the bedd0100p1.xml file**

1. On the **Tools** menu, click **Import Local** as seen in Figure 4-4.
2. Navigate to the appropriate folder where the file exists, and select `bedd0200.xml` and click **Open** (Figure 4-5), to display the **Import** dialog box, as shown in Figure 4-6.
3. In the **Import** dialog box, all items in the list need to be selected and **Compile Imported Items** options needs to be selected.

4. Click **OK**. After the system compiles the EDD package files, the **Compilation finished successfully in...** message appears in the Output pane.

5. A warning dialog box similar to Figure 4-7 may be displayed after the XML file has been imported. Click **OK** to continue.
4.2  BEDD KIDS Installation

1. From the **KIDS** menu, select the **Installation** menu.

2. From the **XPD Main -> Installation** menu, select **Option 1: Load a Distribution**.

3. Type `bedd0200.k` at the “Enter a Host File” prompt. Please note the file path might need to precede the file name with the appropriate host path. This is the file to retrieve from the appropriate software directory.

4. Type **Yes** (or press the ENTER key to accept the default) at the “Want to Continue with Load? YES/?” prompt.

5. KIDS file `bedd0200.k` contains the following installation file:

   **BEDD DASHBOARD 2.0**

6. From the **Installation** menu, select **Option 2: Verify Checksums in Transport Global**. This option provides a mechanism for ensuring the integrity of your routines. This step verifies checksums for the components of the Transport global, and reports any errors uncovered.

7. Type **BEDD DASHBOARD 2.0** as the install name.

   Optional: At this time, you can elect to exercise one of the following installation options. If you elect to use one of these, use **BEDD DASHBOARD 2.0** as the install name.

   a. **Back Up a Transport Global** – this option creates a MailMan message that will back up all current routines on the system that would be replaced by this release.

   b. **Compare Transport Global** – this option allows you to view all changes that will result from the installation of this patch and compares them with the values currently loaded on the system (routines, data dictionaries, templates, etc.).

8. From the **Installation** menu, select the **Install Packages(s)** option.
9. At the **Select Install Name** prompt, type **BEDD DASHBOARD 2.0**.

10. Respond to the following prompts as indicated:

   a. At the “Want KIDS to Rebuild Menu Trees Upon Completion of Install? YES//” prompt, type NO.

   b. At the “Want KIDS to INHIBIT LOGONs during the install?//YES” prompt, type NO.

   c. At the “Want to DISABLE Scheduled Options, Menu Options and Protocols?//” YES prompt, type NO.

11. Type the device that will print the install messages.

12. Exit the **Installation** menu.

### 4.3 Sample Cache Install

**Note:** User responses appear in **bold** type.

| Select OPTION NAME: **XPD MAIN** Kernel Installation & Distribution System |
| Edits and Distribution ... |
| Utilities ... |
| Installation ... |
| Patch Monitor Main Menu ... |
| You have 2 PENDING ALERTS |
| Enter "VA to jump to VIEW ALERTS option |
| You've got PRIORITY mail! |
| Select Kernel Installation & Distribution System Option: Installation |
| 1 Load a Distribution |
| 2 Verify Checksums in Transport Global |
| 3 Print Transport Global |
| 4 Compare Transport Global to Current System |
| 5 Backup a Transport Global |
| 6 Install Package(s) |
| Restart Install of Package(s) |
| Unload a Distribution |
| You have 2 PENDING ALERTS |
| Enter "VA to jump to VIEW ALERTS option |
| You've got PRIORITY mail! |
| Select Installation Option: 1 Load a Distribution |
| Enter a Host File: D:\RPMS_TEST\bedd0200.k  *Note: A site specific path will be required here |
| KIDS Distribution saved on Jun 04, 2014@20:53:28 Comment: BEDD DASHBOARD 2.0 |
This Distribution contains Transport Globals for the following Package(s):
  BEDD DASHBOARD 2.0
Distribution OK!

Want to Continue with Load? YES/
Loading Distribution...

Build BEDD DASHBOARD 2.0 has an Environmental Check Routine
Want to RUN the Environment Check Routine? YES/
  BEDD DASHBOARD 2.0
Will first run the Environment Check Routine, BEDD2ENV

Patch "AMER*3.0*6" is installed.
Use INSTALL NAME: BEDD DASHBOARD 2.0 to install this Distribution.

1      Load a Distribution
2      Verify Checksums in Transport Global
3      Print Transport Global
4      Compare Transport Global to Current System
5      Backup a Transport Global
6      Install Package(s)
      Restart Install of Package(s)
Unload a Distribution

You have 2 PENDING ALERTS
Enter "VA to jump to VIEW ALERTS option

You've got PRIORITY mail!

Select Installation Option: 2  Verify Checksums in Transport Global
Select INSTALL NAME: BEDD DASHBOARD 2.0  Loaded from Distribution
Loaded from Distribution  1/19/15@10:04:38
  => BEDD DASHBOARD 2.0  ;Created on Jun 04, 2014@20:53:28

This Distribution was loaded on Jan 19, 2015@10:04:38 with header of
  BEDD DASHBOARD 2.0  ;Created on Jun 04, 2014@20:53:28
  It consisted of the following Install(s):
    BEDD DASHBOARD 2.0

Want each Routine Listed with Checksums: Yes/  YES
DEVICE: HOME// Virtual

PACKAGE: BEDD DASHBOARD 2.0  Jan 19, 2015 10:04 am  PAGE 1

---------------------------------------------------------------------------
    ----

----
BEDD2ENV  Calculated  2546209
BEDD2PST  Calculated  8173287
BEDDEHR   Calculated  2045184
BEDDEHRS  Calculated  21599952
BEDDINJ   Calculated  17646764
BEDDMREC  Calculated  32819285
BEDDPOV   Calculated  117307512
BEDDSYNC  Calculated  1113686
BEDDTMPT  Calculated  6329164
BEDDUTID  Calculated  171571970
BEDDUTIF  Calculated  694696
BEDDUTIL  Calculated  161512435
BEDDUTIU  Calculated  130929002
BEDDUTL1  Calculated  962138
14 Routines checked, 0 failed.

1. Load a Distribution
2. Verify Checksums in Transport Global
3. Print Transport Global
4. Compare Transport Global to Current System
5. Backup a Transport Global
6. Install Package(s)
   - Restart Install of Package(s)
   - Unload a Distribution

You have 2 PENDING ALERTS
   Enter "VA to jump to VIEW ALERTS option

You've got PRIORITY mail!

Select Installation Option: 6 Install Package(s)
Select INSTALL NAME: BEDD DASHBOARD 2.0 Loaded from Distribution
Loaded from Distribution 1/19/15@10:04:38
=> BEDD DASHBOARD 2.0 ;Created on Jun 04, 2014@20:53:28

This Distribution was loaded on Jan 19, 2015@10:04:38 with header of
   BEDD DASHBOARD 2.0 ;Created on Jun 04, 2014@20:53:28
   It consisted of the following Install(s):
   BEDD DASHBOARD 2.0
Checking Install for Package BEDD DASHBOARD 2.0
Will first run the Environment Check Routine, BEDD2ENV
   Patch "AMER*3.0*6" is installed.

Install Questions for BEDD DASHBOARD 2.0

Want KIDS to INHIBIT LOGONs during the install? NO//
Want to DISABLE Scheduled Options, Menu Options, and Protocols? NO//

Enter the Device you want to print the Install messages.
You can queue the install by enter a 'Q' at the device prompt.
Enter a '^' to abort the install.

DEVICE: HOME// Virtual

Install Started for BEDD DASHBOARD 2.0:
   Jan 19, 2015@10:04:56

Build Distribution Date: Jun 04, 2014

Installing Routines:
   Jan 19, 2015@10:04:57

Running Post-Install Routine: PST^BEDD2PST

Updating Routine file...

Updating KIDS files...

BEDD DASHBOARD 2.0 Installed.
   Jan 19, 2015@10:04:59

Not a VA primary domain
Install Completed

Figure 4-8: Sample Installation
5.0 Installation Configuration

5.1 Add User Security Keys

This section covers entering the appropriate security key to RPMS users requiring access to the BEDD package. If version 1.0 of BEDD has already been installed in the past, this section can be skipped for existing EDD users.

There are two keys installed as part of the KIDS build:

- BEDDZMGR – Key for Manager access to the EDD application
- BEDDZDASH – Key for User access to the EDD application

Add user security keys to RPMS users using the XUKEYMGMT option as shown in Figure 5-1.

1. At the “OPTION NAME:” prompt, type KEY MAN and press Enter.
2. At the “CHOOSE 1-2:” prompt, type 1 (XUKEYMGMT) and press Enter.
3. At the “Select Key Management Option:” prompt, type ALLOC and press Enter.
4. At the “Allocate Key:” prompt, enter BEDDZDASH and press Enter.
5. If the user also needs Manager access to this application, at the “Allocate Key:” prompt re-appears after the previous step, enter BEDDZMGR and press Enter.
6. At the “Holder of Key:” prompt, enter the user’s name to which the key(s) are to be added and press Enter.
7. At the “You are allocating keys. Do you wish to proceed?” prompt, verify your entry and type YES if correct or NO if not, and press Enter.
Select OPTION NAME: **KEY MAN**
1 KEY MANAGEMENT XUKEYMGMT Key Management
2 KEY MANAGEMENT BEHOORKY MAIN Key Management
CHOOSE 1-2: 1 XUKEYMGMT Key Management

Allocation of Security Keys
De-allocation of Security Keys
Enter/Edit of Security Keys
All the Keys a User Needs
Change user's allocated keys to delegated keys
Delegate keys
Keys For a Given Menu Tree
List users holding a certain key
Remove delegated keys
Show the keys of a particular user

Select Key Management Option: **ALLO**Cation of Security Keys

Allocate key: **BEDDZDASH**
Another key: **BEDDZMGR**
Another key:

Holder of key: **USER,TEST**
Another holder:

You've selected the following keys:
**BEDDZMGR** **BEDDZDASH**
You've selected the following holders:
**USER,TEST**

You are allocating keys. Do you wish to proceed? YES/

**BEDDZMGR** being assigned to: 
**USER,TEST**
**BEDDZDASH** being assigned to: 
**USER,TEST**

Figure 5-1: Key Management – Allocate Key(s)

### 5.2 Configuring the Cache Server Page (CSP) Application

**Note:** It is recommended that the site use a standalone Internet Information Services IIS or Apache™ web server with Secure Sockets Layer (SSL) configuration and not the private web server provided by InterSystems. The instructions here are meant to be used for testing purposes only.
Next, configure the security settings for the EDD CSP application which was automatically created by the import and compile process. If you do not complete this step, your Electronic Health Record Graphical User Interface (GUI) application will not be able to display the EDD’s main dashboard page.

5.2.1 Enable System Authentication Options

1. Sign on to the Ensemble System Management Portal

2. Select Security Management under System Administration in the left column. The Security Management page will be displayed.


4. Select Authentication Options in the left column. The screen in Figure 5-2 will appear.

![Figure 5-2: Home->Security Management->Systems Security Settings->Authentication](image)

5. Make sure that the Allow Unauthenticated access box is checked then click Save. The change will take effect immediately.

5.2.2 Create New CSP Application


2. Select CSP Applications in the right column under Application Definitions. A page similar to Figure 5-3 will appear.
3. Select **Create New CSP Application** and fill out the values similar to Figure 5-4.
For CSP Application Name put in /csp/bedd.

For CSP Application Name put in /csp/bedd.

For Allowed Authenticated Methods make sure Unauthenticated is checked.

For Namespace, select the site’s RPMS namespace.

For CSP Files Physical path, locate the directory as <cacheinstance>/csp/<RPMSinstance>.
9. For **Login Page**, put in **BEDDLogin.csp** (this is case-sensitive)

### 5.2.3 Update Ensemble’s UnknownUser

1. Return to the main **Ensemble Management Portal** page. Select **Security Management** under **System Administration** in the left column. The **Security Management** page will be displayed. Select "**Users**" in the left column and the following page similar to Figure 5-5 will appear.

![Figure 5-5: User Management screen](image)

2. Locate the user called **UnknownUser** on this screen. Once found, click the **Edit** link. A screen similar to Figure 5-6 will appear.
Figure 5-6: Edit User screen

3. Click the **Roles** tab immediately under **Edit definition for user UnknownUser** and the **Edit User** screen similar to Figure 5-7 will appear.
4. If the list of roles which appears at the top of the page immediately under **UnknownUser is Assigned to the Following Roles** includes %All, then no further action in this section is required. If not, then select %All in the list of **Available** roles on the left hand side of the page, and click the top arrow located between the **Available** and **Selected** columns.

5. Once %All appears in the **Selected** column, click the **Assign** button and %All will appear under **UnknownUser is Assigned to the Following Roles**.

6. The CSP application portion and security setup is complete.

5.3 CSP Gateway Installation

The CSP Gateway provides the communications layer between the hosting Web server and Ensemble when you call a Caché® Server Page (CSP). The purpose of using the CSP Gateway is to offload the access to the EDD application to a dedicated web server, as well as use SSL communication to encrypt the data between the user and the server.
Note: The instructions in this section assume the site is running Microsoft Internet Information Server (version 7 or higher) with a valid installed SSL certificate. Installation of IIS and SSL certificates are outside the scope of this document.

5.3.1 Install Cache Shell

1. Start by launching the Ensemble executable appropriate for your version of Windows and checking I accept the terms in the license agreement and click Next as indicated in Figure 5-8.

![Figure 5-8: Ensemble Installation](image)

2. Enter a unique Ensemble Instance Name for this physical machine and click Next as indicated in Figure 5-9.
3. On the next screen, enter the path where the Ensemble shell will be located by clicking **Change** as shown in Figure 5-10.
4. Install into the directory `C:\InterSystems\EnsembleCSP` and click **OK** as indicated in Figure 5-11.

![Figure 5-11: Ensemble Installation cont’d](image)

5. Select **Web Server** on the next screen and click **Next** as indicated in Figure 5-12.
6. A screen will appear as in Figure 5-13 allowing a review of the options. Review and click **Install**.
7. If IIS is running you will receive a warning message asking you to stop the IIS WebServer as seen in Figure 5-14. Click Yes and it will stop IIS and continue the installation process.

8. Click Finish to complete the installation as indicated in Figure 5-15.
5.3.2 Configure IIS

1. On the webserver that the CSP gateway was just installed, go the option **Administrative Tools -> IIS Manager** as indicated in Figure 5-16.
2. Select **Default Web Site**, click **csp**, then **Handler Mappings** as indicated in Figure 5-17.
Validate that the CSPGateway_* mappings are present for *.cls, *.csp, *.cxw and *.zen, and that they are listed as Enabled as indicated in Figure 5-18.
4. In order to have IIS handle CSP applications like EDD via IIS, click **Add Module Mapping** and enter values as indicated in Figure 5-19.
5.3.3 Configure CSP Gateway

1. While connected to the server where the CSP Gateway was installed, enter the following link in a web browser: http://localhost/csp/bin/Systems/Module.cxw and the screen shown in Figure 5-20 will appear.
2. Click **Server Access** and **Add Server** as indicated in Figure 5-21.

![Figure 5-21: CSP Gateway configuration cont'd](image)

3. Insert the appropriate site information in the highlighted areas on the following screen as indicated in Figure 5-22, and click **Save Configuration** at the bottom when complete.

![Figure 5-22: CSP Gateway configuration cont'd](image)

4. Click **Application Access** and **Add Application** as indicated in Figure 5-23.
5. On the following screen, for **Application Path**: set to `/csp/bedd` and for **Default Server**: select your previously configured server name from the dropdown, then click **Save** as indicated in Figure 5-24.

6. Click **Test Server Connection**. If successful the following screen will appear similar to Figure 5-25.
7. Enter the website link for the ED Dashboard from a workstation browser, for example: https://npacsmtbmw.d1.na.ihs.gov/csp/bedd/BEDDLogin.csp and the page as shown in Figure 5-26 will appear.

![Figure 5-26: CSP Gateway configuration cont'd](image)

**Note:** If you are using a non-standard port for the https protocol handled by IIS such as 444, you will need to modify the URL you use accordingly as in the following example: https://npacsmtbmw.d1.na.ihs.gov:444/csp/bedd/BEDDLogin.csp
5.4 Application Access Setup

There are two modes of operation for the EDD: Standalone and EHR Portal.

1. Standalone - access via a direct web browser session which requires an active RPMS Access and Verify code to login.

2. EHR portal - access from within the EHR application as separate tab. Note that this also requires an active RPMS Access and Verify code to login, however the user may already have their credentials cached in the EHR application.

5.4.1 Stand Alone Setup

For Standalone access, create an icon on your desktop to call up your web browser for access:

1. On your desktop, right-click and choose New - > Shortcut (Figure 5-27) and enter the following URL (site-specific modifications in BOLD type):

   http://IPADDRESS:PORT/esp/bedd/BEDDLogin.csp

   **IPADDRESS** is the IP name or Address of your Ensemble installation or CSP Gateway

   **PORT** is the port number used for the portal or gateway

   **Note:** Modify the URL to HTTPS if you are using a CSP gateway with an active and signed HTTPS encryption certificate.
2. After entering the URL, press **Next** as in Figure 5-28.

3. In the **Type a name for this shortcut:** prompt, enter **ED Dashboard** and click **Finish** as indicated in Figure 5-29.
Figure 5-29: Name Shortcut

4. Click the new icon to test as indicated in Figure 5-30.

Figure 5-30: Dashboard Login Page

5.4.2 EHR Setup

For access to the EDD from the EHR, the following steps need to be performed in the Design Mode of the EHR application:
1. Open EHR, right-click in the title bar at the top and choose **Design Mode** as indicated in Figure 5-31.

![Design Mode](image)

**Figure 5-31: Enter design mode**

2. Select **Design -> Desktop Properties** as displayed in Figure 5-32.
3. Select **Customize Menus** as displayed in Figure 5-33.
Figure 5-33: Customize Menus

4. Click the plus sign (+) to add and enter a new menu option **ED Dashboard** as seen in Figure 5-34 and Figure 5-35.
Figure 5-34: Customize Menus cont’d

Figure 5-35: Customize Menus cont’d
5. In the **Edit Action Box**, put in the path to Internet Explorer followed by a space and the regular EHR URL as seen in Figure 5-36, where an example value is given. Replace IP address and PORT values with those appropriate for your site.

```
"C:\Program Files\Internet Explorer\iexplore.exe http://IPaddress:PORT
csp/bedd/BEDDLogin.csp?DUZ=$(user.handle)&SITE=$(site.handle)&LOC=EH R
```

6. Click **OK**, **Save Settings** and leave design mode.

7. Click on the new menu option **ED Dashboard**, and the EDD main screen will display as indicated in Figure 5-37.

Figure 5-36: Edit action
Figure 5-37: gv bff Dashboard Display
## Acronym List

<table>
<thead>
<tr>
<th>Acronym</th>
<th>Term Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSP</td>
<td>Cache Server Page</td>
</tr>
<tr>
<td>EDD</td>
<td>Emergency Department Dashboard</td>
</tr>
<tr>
<td>EHR</td>
<td>Electronic Health Record</td>
</tr>
<tr>
<td>ERS</td>
<td>Emergency Room System</td>
</tr>
<tr>
<td>GUI</td>
<td>Graphical User Interface</td>
</tr>
<tr>
<td>IHS</td>
<td>Indian Health Service</td>
</tr>
<tr>
<td>IIS</td>
<td>Internet Information Services</td>
</tr>
<tr>
<td>RPMS</td>
<td>Resource and Patient Management System</td>
</tr>
<tr>
<td>SSL</td>
<td>Secure Sockets Layer</td>
</tr>
</tbody>
</table>
Contact Information

If you have any questions or comments regarding this distribution, please contact the OIT Help Desk (IHS).

Phone: (888) 830-7280 (toll free)
Web: http://www.ihs.gov/helpdesk/
Email: support@ihs.gov